## PIO INCIDENT ORGANIZER

Available online at [https://www.nifc.gov/PIO_bb/docs.html](https://www.nifc.gov/PIO_bb/docs.html) Updated March 27, 2017

<table>
<thead>
<tr>
<th>NAME</th>
<th>O-#</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCIDENT NAME</td>
<td>INCIDENT #</td>
</tr>
<tr>
<td>HOST UNIT</td>
<td>ACCT CODE</td>
</tr>
</tbody>
</table>

### INFO CENTER HOURS:

<table>
<thead>
<tr>
<th>BREAKFAST:</th>
<th>LUNCH:</th>
<th>DINNER:</th>
<th>SHOWERS:</th>
</tr>
</thead>
</table>

### DAILY SCHEDULE

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>AM BRIEFING</td>
<td>PIO Briefings</td>
</tr>
<tr>
<td></td>
<td><em>Situation:</em> Here’s what I think we face.</td>
</tr>
<tr>
<td></td>
<td><em>Task:</em> Here’s what I think we should do.</td>
</tr>
<tr>
<td></td>
<td><em>Intent:</em> Here’s why I think we should do it.</td>
</tr>
<tr>
<td></td>
<td><em>Concern:</em> Here’s what we should keep our eye on because if that changes, we're in a whole new situation.</td>
</tr>
<tr>
<td></td>
<td><em>Calibrate:</em> Now talk to me. Tell me if you don’t understand, cannot do it, or see something I do not.</td>
</tr>
<tr>
<td>PIO AM MEETING</td>
<td></td>
</tr>
<tr>
<td>DISTRIBUTE AM UPDATE</td>
<td></td>
</tr>
<tr>
<td>PRESS CONFERENCE</td>
<td></td>
</tr>
<tr>
<td>PIO COOPERATOR CALL</td>
<td></td>
</tr>
<tr>
<td>COOPERATORS MEETING</td>
<td></td>
</tr>
<tr>
<td>C&amp;G MEETING</td>
<td></td>
</tr>
<tr>
<td>PRE-PLANNING MEETING</td>
<td></td>
</tr>
<tr>
<td>PLANNING MEETING</td>
<td>Who’s acting if lead is unavailable?</td>
</tr>
<tr>
<td>PM BRIEFING</td>
<td>Are PIOs aware of incident-within-incident procedures?</td>
</tr>
<tr>
<td>DISTRIBUTE PM UPDATE</td>
<td>Regular communication with host unit / key contacts?</td>
</tr>
<tr>
<td>COMMUNITY MEETING</td>
<td>Adequate meals / showers / breaks / work-rest ratio?</td>
</tr>
<tr>
<td>PIO PM MEETING</td>
<td>Are we learning from our mistakes?</td>
</tr>
</tbody>
</table>
CALL-OUT / CHECK-IN / SET-UP

**UPON CALL-OUT**
- Notify Supervisor
- Obtain Resource Order
- Incident name?
- Report location? Report date and time?
- Are rental car, laptop, camera, printer, radio and/or cell phone authorized?
- Contact number for lead PIO and/or Expanded Dispatch at the incident?
- Copy of Resource Order to home unit
- Obtain Travel Authorization
- Call Lead PIO with Est. Time of Arrival

**LEAD IMT PIO**
- Call IC for initial briefing
- Call unit PAO to assess needs
- Submit pre-order for PIOs
- Bring or ship team PIO supplies
- Update IMT website with current assignment info

**ALWAYS PACK**
*Max weight 65 lb total - label everything*
- Resource Order
- Red Card
- Federal and/or Team ID
- Taskbook
- Wildland Fire Incident Mgmt Field Guide
- Incident Response Pocket Guide (IRPG)
- Cell phone and charger (if authorized)
- Home Unit Dispatch Phone #
- Home Unit Timekeeper Phone # & Fax #
- Full PPE
- Personal Gear
- PIO Home Unit or Travel Kit

**REQUIRED PPE (<20lb)**
- Nomex pants & shirt
- 8" Leather fire boots & spare laces
- Helmet & Headlamp
- Goggles
- Gloves
- Fire shelter
- Ear plugs
- Water bottles

**PERSONAL GEAR (<45 lb, soft-sided bag)**
- Matches (can’t take on an airplane)
- Signal Mirror
- Compass
- Jackknife (don’t pack in carry on bag)
- Parachute cord
- Granola bar
- First aid kit

**PERSONAL GEAR (continued)**
- Space blanket
- AA batteries
- Hat
- Sunglasses / spare glasses
- Prescriptions
- Sunscreen
- Bug spray
- Bandana
- Rain gear
- Toiletries & flip flops
- Small towel
- Flashlight
- Extra clothing (cotton)
- Warm jacket, hat, gloves
- Alarm clock & AAA batteries if needed
- Tent
- Sleeping Bag & Pad
- Handheld Radio

**PIO TRAVEL KIT**
- Magnetic "Fire Information" signs
- "Fire Information" Banner
- PIO nametag
- Jumpdrive with templates and examples
  https://www.nifc.gov/PIO_bb/docs.html
- Digital camera (if authorized)
- extra batteries and memory cards
- download cable and charger
- Laptop computer & cables (if authorized)
- GPS & cables (if authorized)
- Portable printer, cables, and ink (if authorized)
- Folder for documentation
- Light duty staple gun and staples
- Staple puller or pliers
- Masking tape or painter's tape
- Push pins
- Pens and pencils
- Permanent markers (black and red)
- Highlighters
- Paper clips
- Rubber bands

**PIO HOME UNIT KIT**
- PIO Travel Kit Items
- Unit Logs
- Crew Time Report (CTR) Book
- General Message Forms
- Request for Recognition Forms
- Phone / Answering Machine
- Bulletin Boards
- Clear plastic / trash bags to cover boards
- Laptops Printer / Scanner/ Copier /Fax
PIO HOME UNIT KIT (continued)
- Ink for Printer / Copier / Fax
- Router box / extra network cables
- Surge strip / extension cords
- Copy Paper / Colored Paper
- File Box
- Manila and/or Hanging Folders
- 2-Pocket Folders
- Accordion Folders
- Clear Sleeves / Laminating Pages
- Flip Charts / Markers / Easel
- Dry Erase Board / Markers
- Blank CDs / DVDs and Cases
- 6"x9" Steno pads with rings on top
- Calculator
- Binder Clips
- Post-it Notes
- 3-Ring Binders / 3-Hole Punch
- Laser Pointer
- Duct Tape / Blue Tape / Scotch Tape
- Stapler / Staples / Staple Puller
- Envelopes & Stamps
- Large manila envelopes
- Scissors
- Cardstock or Photo Paper
- Certificate Holders
- Portable TV / Radio
- Handheld people counter / clicker
- AA batteries
- Trash bags
- Calendar
- Interagency Standards for Fire & Fire Aviation Operations (the “Redbook”)
- National Mobilization Guide
- GACC Mobilization Guide
- GACC Media Guide
- Local unit/state highway maps
- Team templates
- Incident-Within-An-Incident Protocol
- Hand tool
- Water
- Hand Sanitizer
- Tissues / Paper Towels
- PPE for Media
- MREs
- Cooler

CHECK-IN
- Check-In (resource order & red card)
- Report to Lead PIO
- Ground Support
- Communications (clone radio, batteries)
- Supply (hand tool, cooler, etc.)
- Training Specialist
- Set up Tent

FIRST OPERATIONAL PERIOD
- PIO Briefing
- Call key contacts: PAO, JIC, Media, etc.
- Set up daily PIO Cooperator call (Ex. freeconferencecall.com)
- Order PIOs via General Message
- Order supplies via General Message
  - Newspapers
  - Yurt / Lights
  - Tables / Chairs
  - Phone / Answering Machine
  - Laptop / Network Connections
  - Printer / copier / fax machine
  - Bulletin Boards
- Map Request via General Message
  - Specify quantity, type (including PDF), and date and time needed
  - Assign 1 person to pick-up
- Coordinate with Liaison Officer
  - Key Contacts, Etc.
  - Set up workspace (phones, etc.)
  - Set up thumbdrive with templates
  - Set up e-mail, Inciweb, Twitter, etc.
  - Set up fire info phone #s and voicemail for public and media
    (Ex. https://www.google.com/voice)
  - Set up Google alerts (google.com/alerts)
  - Prepare and distribute daily update
  - Establish info center location & hours
  - Determine trapline locations
  - Assess taskbook needs
  - Establish Doc Box

ORDERING PIOs
- Order via General Msg – Print Legibly
  - Specify quantity, qualification & report date/time needed
  - Specify if rental car, laptop, cell phone, camera and/or printer are authorized
  - If name request, specify name in ROSS, qualification, phone number(s), home unit id, and home unit dispatch & phone.

DOC BOX LABELS
- Community Relations / PSAs
- Closure Orders / Restrictions
- Info Summary / Comm Strategy
- Media Log / Key Contacts / Traplines
- Newspaper Clippings
- Press Releases / Daily Fire Updates
- Public Meetings / Briefings
- Special Events / Tours / VIP Visits
- Thank You Letters
- Web Pages / Videos / Photos
- Unit Logs
- General Messages
IN-BRIEFING

Review:
- Incident Action Plan (IAP)
- ICS-209, Incident Status Summary
- Delegation of Authority (especially review expectations for incident information protocol)
- Transition plan
- Wildland Fire Decision Support System (WFDSS)
- Fire Management Plan / Fire History
- List of current / ordered resources
<table>
<thead>
<tr>
<th>IN-BRIEF</th>
<th>Date/Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Name</td>
<td>Complexity</td>
</tr>
<tr>
<td>IMT Name</td>
<td>IC Name</td>
</tr>
<tr>
<td>Ownership</td>
<td>Jurisdiction</td>
</tr>
<tr>
<td>Location</td>
<td>County</td>
</tr>
<tr>
<td>Legal</td>
<td>Coordinates</td>
</tr>
<tr>
<td>Cause</td>
<td>Elevation</td>
</tr>
<tr>
<td>Reported by</td>
<td>Reported When</td>
</tr>
<tr>
<td>Date of Origin</td>
<td>Time of Origin</td>
</tr>
<tr>
<td>Estimated Size</td>
<td>Estimated % Containment</td>
</tr>
<tr>
<td>Est Containment Date/Time</td>
<td>Est Control Date/Time</td>
</tr>
<tr>
<td>Injuries</td>
<td>Cost</td>
</tr>
</tbody>
</table>

**Resources Responding (show how many)**

<table>
<thead>
<tr>
<th>Type 1 Engines</th>
<th>Type 1 Handcrews</th>
<th>Type 1 Helicopters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type 2 Engines</td>
<td>Type 2 Handcrews</td>
<td>Type 2 Helicopters</td>
</tr>
<tr>
<td>Type 3 Engines</td>
<td>Modules</td>
<td>Type 3 Helicopters</td>
</tr>
<tr>
<td>Type 4 Engines</td>
<td>Overhead</td>
<td>Air Tankers</td>
</tr>
<tr>
<td>Type 5 Engines</td>
<td>Dozers</td>
<td>SEATs</td>
</tr>
<tr>
<td>Type 6 Engines</td>
<td>Water Tenders</td>
<td>Retardant Drops</td>
</tr>
<tr>
<td>Type 7 Engines</td>
<td>Other</td>
<td>Water Drops</td>
</tr>
</tbody>
</table>

**Values at Risk**

- Structures Threatened:
- Damaged:
- Destroyed:

**Evacuations**

**Restrictions**

**Closures**

**Cooperators**

**Fire Behavior**
<table>
<thead>
<tr>
<th>Fuel Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Topography</td>
<td></td>
</tr>
<tr>
<td><strong>Weather</strong></td>
<td></td>
</tr>
<tr>
<td>Growth Potential</td>
<td></td>
</tr>
<tr>
<td><strong>Current Status</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Current Actions</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Planned Actions</strong></td>
<td></td>
</tr>
<tr>
<td>Smoke</td>
<td></td>
</tr>
<tr>
<td>Socio/Political Concerns</td>
<td></td>
</tr>
<tr>
<td>Other Current Incidents in the Area</td>
<td></td>
</tr>
<tr>
<td>Significant Past Incidents</td>
<td></td>
</tr>
</tbody>
</table>
QUESTIONS FOR HOST UNIT PUBLIC AFFAIRS OFFICER (PAO)
Always Check In Regularly With the Local PAOs for All Agencies on the Delegation of Authority

<table>
<thead>
<tr>
<th>Management, Leadership and Decision Making</th>
<th>Community Contacts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified Command?</td>
<td>Evacuation centers, trap lines, etc.? When, where and how often? Which ranger stations should be on the trapline? Local translators available?</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Incident Info Center</th>
<th>Website</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location, who will manage, staffing, hours, phone numbers?</td>
<td>Inciweb or other? Use of social media? Who will coordinate, update, how often? Local unit webmaster? Passwords?</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Incident Info Field Operations</th>
<th>Community Meetings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location, agencies involved, who will coordinate?</td>
<td>Location, format, how often? Who will manage / conduct? Role of the agency official? Translators?</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Logistical Support</th>
<th>Media/Press Conferences</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is computer, phone, cell, e-mail capacity of incident? Laminator, LCD projector, printer, fax, etc.? Phones at ranger station, EOC, etc.?</td>
<td>Media coordination, how often, who will conduct, who will send information to media?</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Daily Fact Sheets</th>
<th>Elected official coordination, meetings and onsite tours of the incident. Who will contact and coordinate?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who is responsible, how often, who will prepare, what template will be used, which logos to use?</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Press Releases on Fire Activity</th>
<th>Documentation of the Incident</th>
</tr>
</thead>
<tbody>
<tr>
<td>What template will be used, who approves, etc.? Translations?</td>
<td>Specific needs? Who will monitor media coverage TV, radio, newspaper, web, social media?</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Contacts</th>
<th>Incident Communications Strategies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email and phone lists (Agency, Media, Elected Officials, Community, etc) Who will send out?</td>
<td>Protocol for release of critical info? Leads &amp; Deputies?</td>
</tr>
</tbody>
</table>

| Sensitive Topics | |
|------------------||
| What are they? Who will handle? | |

### CHECKLIST OF ROLES TO DISCUSS WITH EMERGENCY OPERATIONS CENTER (EOC) or JOINT INFORMATION CENTER (JIC) PIO

<table>
<thead>
<tr>
<th>Local PIO Resources</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

7
PAO / PIO ROLES AND RESPONSIBILITIES

Host Unit PAO
- Prepares / updates home unit emergency communications plan prior to incident
- Through the agency administrator (AA), and in discussion with the incident lead PIO, assigns info objectives and duties to the incoming PIO. Assigned PIO duties may include part or all of the emergency info responsibilities such as: community info, info center management, media contacts, web updates, daily info sheet updates, interagency info sharing, media briefings, the use of team and agency logos
- The agency Public Affairs Officer (PAO) usually retains some or all duties that directly support the AA such as: congressional and other elected official contacts, agency lead on fatalities or serious accidents during the initial stages, spokesperson on issues related to agency policy, announcement of the cause of fires, media conferences.

Team PIO
- Designs / executes an incident info strategy to achieve the AA’s assigned objectives.
- Orders, assigns duties, and evaluates assistant PIOs working for IMT.
- Manages incident-within-an-incident in close coordination with PAO.
- Follows AA’s protocol for fatalities and serious accidents.
- Conducts community meetings requested by AA.
- Develops / implements strategy to keep incident personnel informed.
- Advises IC on emerging issues and communication strategies.
- Coordinates with other incident PIOs in the area including JIC.
- Demobilizes PIO personnel and resources.
- Prepares transition plan and incident PIO narrative.

Leader’s Intent for PIO Staff
Be Safe – Be Professional – Maintain Positive Relations

DUTY
- Provide clear, accurate, timely info to internal and external audiences.
- Maintain situational awareness.
- Maintain incident documentation.

RESPECT
- Demonstrate courtesy and tolerance.
- Work as a team for the greater good.
- Honor commitments, deadlines, and others’ time.

INTEGRITY
- Know yourself and seek improvement.
- Seek and accept responsibility for your actions.
- Resolve issues at lowest level.

Area Command
- Develop / execute info strategy designed to meet AA’s objectives as outlined in the Delegation of Authority.
- Coordinates with unit PAO to reduce duplication of efforts and strengthen relationships.
- Inventories personnel assigned within the command.
- Assists in filling PIO resource orders as needed by PIOs within the Command.
- Manages an info center that meets AA objectives.
- After discussions with Lead PIOs and ICs, reassigns info resources as needed within the command.
- Orders, assigns work, and evaluations PIO personnel working for AC.
- Supports incident PIOs in obtaining info/resources they need to accomplish their mission (ie. road closure / evacuation info)
- Supports AC info needs.
- Provides media with summary briefings on incidents within the command.
- Facilitates info sharing / issue identification among incident PIOs within the command.
JOINT INFORMATION CENTER (JIC) ROLES AND RESPONSIBILITIES


Lead PIO:
• responsible for managing the JIC;
• serves as advisor to IC/UC;
• provides overall communication policy direction;
• recommends and develops strategy for messages, briefings, and news releases;
• obtains approval from those in authority before releases are made; and
• conducts JIS/JIC briefings (live or virtual) to update staff regarding Incident Command activities.

Information Gathering:
• Response Partners – Coordination with supporting response agencies and their PIOs at EOCs, incident command posts, and other locations to gather information on the incident.
• Media Monitoring Analysis/Rapid Response – Entails reviewing media reports for accuracy, content, and possible response.
• Research and Writing:
  - Products – Writing materials such as media releases, fact sheets, flyers, etc.
  - Graphics Support – Entails designing layouts, developing PowerPoint presentations, and creating graphics for a range of materials (e.g., newsletters, flyers, etc.).
• Audio-Visual:
  - Broadcast Operations – Entails developing video documentation, special productions, remote live interview feeds, and logistical support of public meetings and presentations.
  - Photo Video – Entails providing still photography documentation to support print and internet media needs, and video documentation to support broadcast media needs. Also includes collecting materials for agency archives.

Information Dissemination:
• Briefing/Special Events – Entails handling events such as news conferences, media briefings, VIP visits, and tours for senior officials of affected areas.
• Media Relations:
  - News Desk – Serves as the primary point of contact for the media.
  - Spokesperson – Prepares and conducts regular news briefings and conferences.
• Web Support – Entails creating and maintaining web pages and blogs containing information about the incident for use by the public and the media.
• Public Inquiries – Entails responding to questions from citizens, making referrals, and developing a log of telephone calls, e-mails, etc., containing names, addresses, the type of calls, and any necessary follow up actions.

Operations Support:
• Special Needs/Multilingual – Entails providing language translation and other services to ensure appropriate and timely information reaches those in the affected areas with special needs.
• Facility Support – Coordinates with the JIC Facility Liaison to maintain and support the JIC operations concerning the facility and resources.

Liaison:
Provides a coordinated two-way communication link with key program areas and other entities involved in the response and recovery operation (e.g., elected officials, community leaders, VIPs, and other governmental and NGO support agencies).

DEMOBILIZING THE JOINT INFORMATION CENTER (JIC)
• prepare a comprehensive deactivation news release for lead-agency approval and distribution;
• notify community, media, agency communications managers and local officials about closing and provide regional contact information;
• provide casebooks to communication managers whose organizations will assume responsibility for ongoing information;
• complete an after-action report and participate in evaluation discussions;
• return borrowed equipment and supplies;
• inventory equipment and supplies; and
• replenish “Go Kits” as necessary.
COMMUNICATION STRATEGY

SITUATION / SOCIO-POLITICAL CONCERNS

AUDIENCE
- Local communities / businesses
- Visitors / recreationists
- Media
- Elected officials
- Agency Personnel
- Incident Personnel
- Partner Agencies
- Nearby Incidents

OBJECTIVES
- Keep internal and external audiences informed with accurate, timely information.
- Be the first and best source of information about the fire; Update information frequently.
- Address rumors to prevent confusion.
- Accommodate media requests quickly and safely.
- Communicate consistent messages about the benefits and risks associated with wildland fire.
- Collaborate with interagency and community partners for maximum efficiency and effect.

STAFFING
Current
Target

KEY MESSAGES
- The safety of firefighters and the public is always the highest priority during wildfires.
- Wildfire behavior is largely contingent upon weather and fuel conditions.
- Partnerships at local, regional, and national levels help us be more effective fire managers.
- Homeowners and communities can help firefighters by creating defensible space around homes and structures.
- Unauthorized use of unmanned aircraft, also known as UAS, “drones,” or remote controlled model aircraft, in a fire area endangers the lives of pilots and firefighters.

TACTICS
- Info Center
- Daily Briefings
- Daily Updates and/or News Releases
- Notification Calls to Key Contacts
- E-mail
- Host Unit Website
- Interagency Fire Info Website
- Business Cards with Fire Info # / links
- Fire Info Boards
- Traplines
- Roving Contacts
- Community Meetings
- Community Events
- Educational Handouts - Firewise, etc.
- Media Escorts
- Press Conference
- Public Service Announcements
- Tours of Camp / Fire
- VIP Briefing Packets
- Camp Boards
- Info for Spike Camp
- Employee Meetings
- Incident Newsletter
- Streaming
- Other

EVALUATION
- Accurate media coverage? Web chatter? Community feedback? Host unit feedback?
- See Sample Activity Report Template on p. 37
- google.com/alerts
- socialmention.com
- Hootsuite.com

Site Analytics – Twitter, Facebook, etc.
The national themes are designed to be broad in scope so communicators can tailor the message to meet the needs of the local situation. Check the link above for updates.

1. **The safety of firefighters and the public is always the highest priority during wildfires.**
   - During wildfires, agency administrators and incident managers make choices to minimize risk and focus on areas where firefighters can be the most effective.
   - No natural or cultural resource or structure is worth the life of a firefighter.

2. **Wildfire behavior is largely contingent upon weather and fuels conditions.**
   - The 2016 fire season was below normal for number of reported wildfires (92 percent of the 10-year annual average). There were 67,743 wildfires reported nationally (compared to 68,151 wildfires reported in 2015).
   - The number of acres burned was also below normal in 2016 with 5,509,995 acres or 79 percent of the national 10-year average.
   - Even though the 2016 fire season was below normal, research continues to show that we can expect to see longer fire seasons, bigger wildfire, and more extreme fire behavior.

3. **Partnerships at local, regional, and national levels help us be more effective fire managers.**
   - Together, we can be more effective than as individual agencies.
   - Projects that reduce vegetation across land management boundaries help create more resilient ecosystems.

4. **Homeowners and communities can help firefighters by creating defensible space around homes and structures.**
   - Taking individual responsibility to reduce flammable materials around homes and communities before a fire occurs can help keep the public and firefighters safe.
   - No human life is worth a home or structure; we will not risk firefighters’ lives to save indefensible homes.

5. **Unauthorized use of unmanned aircraft, also known as UAS, “drones,” or remote controlled model aircraft, in a fire area endangers the lives of pilots and firefighters.**
   - Never fly unmanned aircraft over or near fires.
   - See No Drone Zone graphics available at https://www.faa.gov/uas/no_drone_zone/.
   - See NIFC’s No Drone Zone website and PSA at https://www.nifc.gov/drones/.
KEY MESSAGES

Key Message:

Key Message:

Key Message:

Generally PIOs on incidents can respond to questions from all news media, including national news media, about the incident only. PIOs should refer all questions that are broader in scope to the host unit Public Affairs Officer to determine whether they should be addresses locally, regionally or nationally.

<table>
<thead>
<tr>
<th>MEDIA INTERVIEW TIPS</th>
<th>ANSWERS TO DIFFICULT QUESTIONS</th>
<th>ESCORTED FIRELINE VISITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare Three Key Messages</td>
<td>Asked about a problem? Talk about a solution. Use Your Key Messages</td>
<td>Visits to the fireline must have the approval of the IC/Burn Boss.</td>
</tr>
<tr>
<td>Ask Reporter Before the Interview</td>
<td>- This is an evolving situation and I will update you as soon as we have additional information. - Everyone is working hard to reach their objectives safely and efficiently - All of our efforts are directed at bringing the situation under control. - I’m not the authority on that subject. You should talk to… - I am unfamiliar with that statement and am not prepared to respond to it. - I will look into it and get back to you. - That’s a hypothetical question and it’s not appropriate for me to speculate. - Our job is to manage public lands according to the law, balancing public use and resource protection.</td>
<td>Visitors must maintain communication with DIVS or fireline supervisor.</td>
</tr>
<tr>
<td>During the Interview</td>
<td>- When you’re done, be quiet. - If you botch the answer, ask to start again (if taped). - Remove sunglasses / hats. - Look at the reporter, not the camera. - NEVER talk “off the record.” - Don’t speculate, give opinion or say “no comment.” - Don’t speak for other agencies. - Avoid yes/no answers. - Don’t disagree with reporter, instead clarify and correct the information.</td>
<td>Visitors must have training in the proper use of PPE &amp; shelter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Escorts must be qualified single resource boss or approved by IC / Burn Boss.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Required PPE:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Wildland fire boots</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Long sleeve aramid shirt</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Flame resistant trousers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Hard hat with chinstrap</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Leather gloves</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Fire shelter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Cotton undergarments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Requirement for hand tool and water to be determined by escort.</td>
</tr>
</tbody>
</table>

### TASKS

- Clone Radio
- Lunch / Water
- Shower / Break
- Call Home
- Check Work E-mail
- Check Work Voicemail
- CTR
- Unit Log
- Charge Cell / Camera

<table>
<thead>
<tr>
<th>TASK</th>
<th>DATE</th>
<th>DATE</th>
<th>DATE</th>
<th>DATE</th>
<th>DATE</th>
<th>DATE</th>
<th>DATE</th>
<th>DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick up Maps</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print / Make Copies</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AM Briefing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Press Conference</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cooperator PIO Call</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cooperator Meeting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update PAO &amp; WO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draft AM/PM Update</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E-mail Daily Update</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Staff Info Center</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phones</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIP Packet / Escort</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Staff Evac Center</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trapline</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mail</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camp Boards</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camp Tour</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media Escort</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inciweb / Website(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Respond to E-mail</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Social Media</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monitor News/Web</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photos / Videos</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C&amp;G Meeting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planning Meeting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Community Meeting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM Briefing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Map Request</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Doc Box</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### SPECIAL PROJECT

<table>
<thead>
<tr>
<th>PROJECT</th>
<th>ASSIGNED TO</th>
<th>DUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Strategy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Demob Plan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transition Plan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Executive Summary</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thank Yous</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ensure Documentation is Complete</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## PLOTTER PAPER SIZES

<table>
<thead>
<tr>
<th>Size</th>
<th>Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI C</td>
<td>17 x 22</td>
</tr>
<tr>
<td>ANSI D</td>
<td>22 x 34</td>
</tr>
<tr>
<td>ANSI E</td>
<td>34 x 44</td>
</tr>
<tr>
<td>ARCH A</td>
<td>9 x 12</td>
</tr>
<tr>
<td>ARCH B</td>
<td>12 x 18</td>
</tr>
<tr>
<td>ARCH C</td>
<td>18 x 24</td>
</tr>
<tr>
<td>ARCH D</td>
<td>24 x 36</td>
</tr>
<tr>
<td>ARCH E</td>
<td>36 x 48</td>
</tr>
</tbody>
</table>

## TRAPLINE

*Local Businesses, Ranger Stations, Road Block Staff, ICP Security, ICP Boards, Helibase, etc.*

<table>
<thead>
<tr>
<th>Location</th>
<th>Notes (pins, tape, etc.)</th>
<th>What’s Posted</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## EQUIPMENT

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Assigned To</th>
<th>Out</th>
<th>In</th>
<th>Return To</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

14
<table>
<thead>
<tr>
<th>PIO RESOURCES - If span of control exceeds 3-7, make changes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avail Extend</td>
</tr>
<tr>
<td>Day 14</td>
</tr>
<tr>
<td>Day 1</td>
</tr>
<tr>
<td>Home Unit</td>
</tr>
<tr>
<td>Lodging</td>
</tr>
<tr>
<td>O-#</td>
</tr>
<tr>
<td>Vehicle</td>
</tr>
<tr>
<td>Task book</td>
</tr>
<tr>
<td>Qual</td>
</tr>
<tr>
<td>Cell</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>KEY CONTACTS</td>
</tr>
<tr>
<td>---------------------------</td>
</tr>
<tr>
<td>HOME UNIT TIMEKEEPER</td>
</tr>
<tr>
<td>HOME UNIT DISPATCH</td>
</tr>
<tr>
<td>FIRE INFO</td>
</tr>
<tr>
<td>IC</td>
</tr>
<tr>
<td>DEPUTY IC</td>
</tr>
<tr>
<td>LIOF</td>
</tr>
<tr>
<td>AGENCY ADMINISTRATOR</td>
</tr>
<tr>
<td>PAO</td>
</tr>
<tr>
<td>Concur Travel (USFS)</td>
</tr>
<tr>
<td>Concur Travel (DOI)</td>
</tr>
<tr>
<td>Wildland Firefighter Foundation</td>
</tr>
<tr>
<td>Disaster Distress Helpline</td>
</tr>
<tr>
<td>Christine Cozakos</td>
</tr>
<tr>
<td>Randy Eardley</td>
</tr>
<tr>
<td>Robyn Broyles</td>
</tr>
<tr>
<td>Tina Boehle</td>
</tr>
<tr>
<td>Robert Eaton</td>
</tr>
<tr>
<td>**Jennifer Jones</td>
</tr>
<tr>
<td>*Isaiah Hirschfield</td>
</tr>
<tr>
<td>*USFS WO Acting Public Affairs Specialist</td>
</tr>
<tr>
<td>^Erin O’Connor</td>
</tr>
<tr>
<td>^Kathryn “Katie” O’Conner</td>
</tr>
</tbody>
</table>

*Notify about all federal and non-federal fires of interest to the news media, elected officials, and senior USFS and USDA leadership

^Work with the local or regional USFS PAO to notify about all VIP visits on USFS incidents
<table>
<thead>
<tr>
<th>KEY CONTACTS</th>
<th>NAME</th>
<th>CONTACT INFO</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXPANDED DISPATCH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AGENCY WEBMASTER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AREA COMMAND</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EOC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SHERIFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RED CROSS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME</td>
<td>DATE / TIME</td>
<td>AFFILIATION</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONTACT LOG</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>NOTES</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PHONE / E-MAIL</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AFFILIATION</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>NAME</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>DATE / TIME</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
<tr>
<td>Date / Time</td>
<td>Major Events</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
<td></td>
</tr>
</tbody>
</table>
## SUMMARY OF ACTIONS (ICS 214)

<table>
<thead>
<tr>
<th>Date / Time</th>
<th>Major Events</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>


### SUMMARY OF ACTIONS (ICS 214)

<table>
<thead>
<tr>
<th>Date / Time</th>
<th>Major Events</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Important decisions, significant events, briefings, reports on conditions, etc.</td>
</tr>
</tbody>
</table>

...
SAVING INCIDENT MAPS FROM FTP
http://ftp.nifc.gov/incident_specific_data
  > double click on appropriate GACC
  > double click on appropriate folder for current year incidents (skip this step if fire names are listed in this folder)
  > double click on incident name
  > double click on “GIS”
  > double click on “Products”
  > double click on folder with current date
  - Right click on the file you want to save
  - Select “Save Link As” and save it to your desktop or somewhere you can find it

SAVE a PDF as a JPG
  - Double click on the pdf file
  - “Edit” > “Copy File to Clipboard”
  - “File” > “Exit”
  - Click on the “Start” Menu, “All Programs” > “Accessories” > “Paint”
  - “Edit” > “Paste”
  - Then click “Crop” in the toolbar
  - “File” > “Save As”
  - Rename the file to something relevant like CubComplexBriefingMap_07-07-08
  - Click on the down arrow to change “save as type” to “jpg”
  - Click on the down arrow to change the “save in” location to the desktop or appropriate folder
  - “Save”

RESIZE PHOTOS
With Microsoft Office Picture Manager
  - Right click on image
  - “Open With” > “Microsoft Office Picture Manager”
  - “Picture” > “Compress Pictures”
  - “Web pages”
  - “OK”
  - “File” > “Save As”
  - Rename the file
  - “Save”

Or Resize Photos With Paint
  - Right click on image
  - “Open With” > “Paint”
  - Click on “Select” then “Select All”
  - Click on “Resize”
  - Resize by Percentage or Pixels
  - Click on “Crop”
  - “File” > “Save As”
  - Rename the file & select “JPG”
  - “Save”

BATCH RESIZE ALL PHOTOS
IN A FOLDER
  - Select the folder you want to resize
  - Right click, “Copy”
  - Then right click and “Paste” on desktop
  - Right click on the folder you just created
  - Right click and “Rename” as Photos for Web or something similar
  - Double click on the folder
  - “Edit” > “Select All”
  - “Open With” > “Microsoft Office Picture Manager”
  - “View” > “Thumbnails”
  - “Edit” > “Select All”
  - “Picture” > “Compress Pictures”
  - “Web pages”
  - “OK”, then “File” > “Save All”

BATCH RENAME ALL PHOTOS
IN A FOLDER
  - Double click on the photo folder
  - “Edit” > “Select All”
  - “Open With” > “Microsoft Office Picture Manager”
  - “View” > “Thumbnails”
  - “Edit” > “Select All”
  - “Edit” > “Rename”
  - Change the file name then select “OK”

Or Batch Rename in Windows Explorer
  - Select multiple files in a folder. To do so, press and hold down the CTRL key while you are clicking files.
  - After you select the files, press F2.
  - Type the new name, then press ENTER.
  - Files will be renamed & numbered chronologically.

PAUSE BEFORE POSTING IMAGES
Consider agency guidelines and potential ramifications before posting pictures of:
  - fireline personnel not wearing full PPE
  - identifiable structures (ie. addresses)
  - burning / burned structures
  - inmate crews
  - faces of children
  - accident or investigation scenes
  - sensitive natural or cultural resources
  - whiteboards / flipcharts with passwords or internal contacts listed

ACCESSIBLE VIDEO & SOCIAL MEDIA
http://bit.ly/AccessibleVideoSocialMedia

ORDERING

INITIAL SETUP
☐ Create incident g-mail account (http://bit.ly/PIOEmail)
☐ Create mass e-delivery account if needed (http://bit.ly/HowToGovDelivery)
☐ Request Inciweb access from host unit (http://bit.ly/Inciweb)
☐ Determine protocol for posting to a backup website (host unit, partner agency, team site, etc.)
☐ Request social media access from host unit (Flickr, Twitter, etc.)
☐ Set IMT and host unit Twitter and/or Facebook to autopost Inciweb Incident RSS Feed (http://bit.ly/Autopost)
☐ Work with partners or VOST (to create incident social media accounts if needed (Accessibility tips http://bit.ly/tips508)
☐ Create incident QR code (http://bit.ly/HowToQRCode)
☐ Set up (Google.com/alerts)
☐ Set up Google Voice (https://www.google.com/voice)

AM
☐ Stream AM Briefing
☐ Post News Release to Inciweb, Backup Website and Social Media
☐ E-mail News Release
☐ Check FTP for maps and post to Inciweb, Backup Website and Social Media (p. 34)

PM
☐ Post News Release to Inciweb, Backup Website and Social Media
☐ E-mail News Release
☐ Check FTP for maps and post if new maps available (p.34)

ONGOING
☐ Monitor and reply to e-mail
☐ Update and maintain e-mail list
☐ Send Internal Texts for PIOs (http://bit.ly/InternalText) as approved by lead PIO (and IC, OPS and LIOF)
☐ Update list of PIO cell numbers
☐ Monitor and reply to online comments (http://bit.ly/CommentGuidelines)
☐ Identify and document media, partner agency, and other key sites and monitor accordingly (http://bit.ly/HowToMonitor)
☐ Identify rumors and respond accordingly
☐ PDF and/or print interesting, significant, or controversial articles for documentation
☐ PDF and/or print Incident Websites and Social media daily for documentation
☐ Update and maintain Google Docs
☐ Update and maintain documentation on multimedia protocols
☐ Check FTP for maps and post if new maps available
☐ Post announcements (public meetings, partner agency news releases, restrictions, etc.) to Inciweb, Backup Website and Social Media
☐ Manage, Label and Upload photos and videos as available

CLOSEOUT
☐ Prepare social media analytics (http://bit.ly/HowToAnalytics)
☐ Tally stats (p.37) for Executive Summary
☐ Prepares transition info (passwords, protocols, etc.)
☐ Give host unit and/or next IMT access to incident g-mail and social media
☐ Ensure Google Drive file is complete
☐ Ensure hard copies of websites are submitted to documentation
☐ Provide an electronic copy of PIO documentation to host unit PAO
☐ Post final closeout message with where to go or who to contact for fire info
☐ Set up g-mail automated response with who to contact for fire info
VIP VISIT

- USFS: Notify WO, Fire Desk & NIFC
- Who to invite? Work with AA, IC & PAO.
- Invite them to visit & provide incident info
- Notify the IC and security manager
- Confirm departure and return times
- Confirm specific areas the tour will cover
- Arrange for appropriate vehicles(s).
- Arrange aircraft with air ops branch director (Note: federal law restricts use of public aircraft for this purpose.)
- Assign a tour guide who knows the area and can answer questions
- Provide all appropriate safety gear
- Arrange for lunch / water
- Provide tour guide with a list of the dignitaries' proper names and titles.
- Security provided? By Whom?
- Expect a group of assistants to arrive with each dignitary.
- Prepare briefing packet(s)

PRESS CONFERENCE

- Get the IC’s approval.
- Contact dignitary’s press person and involve in the planning.
- Establish a facilitator with maps.
- Select the site, considering:
  - Close to the action without interfering in the operation.
  - Room for cameras, light stands, microphones, satellite truck parking,
  - Speakers should be on a riser where they can be seen and photographed.
  - Consider what is behind the speaker, (ex, a window would glare on TV).
  - Access to power for PA equipment.
- Notify the media of the time, place, and purpose of the briefing and who will be speaking. Include a contact name and phone number.
- Prepare handouts and maps with current info on the incident and an agenda with the names and titles of the speakers. Distribute to the media as they arrive.
- A facilitator should announce the purpose of the news conference explain any ground rules, and introduce each speaker. That person should keep the briefing moving and coordinate questions and answers after the speakers are finished.
- Remember every mic is a live mic.

PUBLIC MEETING

Agenda:

- Assign a facilitator.
- Confirm agenda and speakers.
- Include IC, Liaison Officer, Operations, Agency Rep, Unified Commander, PIO, Community Leaders, and Sheriff.

Location:

- Adequate seating / parking
- Inside / outside
- Lighting
- Backdrop – facing sun?
- AV / PA system (test upon arrival)
- Power source
- Overflow contingency?

Supplies:

- Duct Tape
- Staple gun and staples
- Tape (scotch and masking)
- Pushpins
- Staple remover tool
- Laser pointer
- Flip charts / markers
- Extension cord / Surge strip

Visuals:

- Powerpoint / photos / videos / posters
- Locate projector / screen
- Order large briefing maps including fire location, fire history, and IR
- Board for posting visuals & maps
- Large fire information phone #s to post
- Fire Info Banner

Handouts:

- Sign-in sheet with clipboards / pens
- Fire maps
- Press releases
- Firewise materials
- Smoke information (State AQ Dept)
- Evacuation information (Sheriff)
- Red Cross information (Sheriff)

Notifications:

- Local Agency Representatives
- Partner land management agencies
- Law enforcement
- City/county government officials
- State/U.S. legislators
- Permittees
- Team members: IC, PSC, OPS, SOF
- Joint Information Center (JIC)
- MAC Group
- Area Command
- Red Cross

37
# ACTIVITY REPORT

## MEDIA

<table>
<thead>
<tr>
<th>Activity</th>
<th>Hours staffed</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td># interviews, in person</td>
<td></td>
<td></td>
</tr>
<tr>
<td># interviews, phone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Translator available (Y/N)</td>
<td></td>
<td></td>
</tr>
<tr>
<td># escort tours, camp</td>
<td></td>
<td></td>
</tr>
<tr>
<td># escort tours, line</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Description: Light, moderate, heavy coverage? Local, regional, national, international interest?

## COMMUNITY

<table>
<thead>
<tr>
<th>Activity</th>
<th>#</th>
<th>In which communities:</th>
</tr>
</thead>
<tbody>
<tr>
<td># Trapline miles</td>
<td></td>
<td></td>
</tr>
<tr>
<td># Trapline stops</td>
<td></td>
<td></td>
</tr>
<tr>
<td># staffed info locations:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## INFO CENTER

<table>
<thead>
<tr>
<th>Activity</th>
<th>#</th>
<th>In which locations:</th>
</tr>
</thead>
<tbody>
<tr>
<td># phone calls taken</td>
<td></td>
<td></td>
</tr>
<tr>
<td># walk-in visitors</td>
<td></td>
<td></td>
</tr>
<tr>
<td># written updates</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Translator available (Y/N)

## ELECTRONIC MEDIA

<table>
<thead>
<tr>
<th>Activity</th>
<th>#</th>
<th>In which locations:</th>
</tr>
</thead>
<tbody>
<tr>
<td># web pages updated</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Social media views

Social media shares

Social media reach

## EXECUTIVE SUMMARY

### SIGNIFICANT EVENTS

### CHALLENGES & RESOLUTIONS

### LESSONS LEARNED

### MANAGEMENT EFFICIENCIES

38
TRANSITION / CLOSE-OUT

TRANSITION PLAN
- Remaining staff & planned demob
- Staffing recommendations
- Info center / trapline locations
- Schedule of conference calls, etc.
- Talking points / key messages
- Recommended tasks
- Political considerations
- Contacts
- Passwords

TRANSITION CLOSE-OUT
- Requests for Recognition
- Request Demobs In Advance (specify name, O#, date and time of release, method of transportation, jetport, and if reservation have already been made or if you're requesting they be made)
- Performance Criteria:
  - Knowledge of the job
  - Ability to work with others
  - Organizational skills
  - Attitude
  - Safety
  - Leadership
  - Flexibility
  - Obtain necessary supplies
  - Media interaction
  - Community interaction
  - Initiative
- Burn DVD for Doc Box
- Doc Box to Plans
- Community Relations / PSAs
- Closure Orders / Restrictions
- Info Summary / Comm Strategy
- Media Log / Key Contacts / Traplines
- Newspaper Clippings
- Press Releases / Daily Fire Updates
- Public Meetings / Briefings
- Special Events / Tours / VIP Visits
- Thank You Letters
- Web Pages / Videos / Photos
- Unit Logs
- General Messages

AFTER ACTION REVIEW
- Focus on the what, not who.
- What did we set out to do?
- What actually happened?
- Why did it happen?
- What are we going to do next time?
  - Sustain/Maintain Strengths
  - Improve Weaknesses

FINAL CLOSE-OUT
- Tear Down Trapline / Boards
- Final update on Inciweb website
- Cancel Newspapers
- Cancel Phones/Internet
- Return Equipment

DEMOB
- Check on Travel Arrangements
- Ground Support
- Supply
- Time
- Training Specialist

UPON RETURN HOME
- Call Dispatch
- Update ROSS status
- Keep a copy of your resource order, fire timesheet, and performance evaluation for your records.
- Make a copy of your taskbook and keep it in a safe place in case you ever lose the original.
- Submit your fire timesheet to your home unit timekeeper.
- Submit a travel voucher to your home unit travel coordinator; attach a copy of your resource order.

POST-SEASON
- Submit an updated IQCS Individual Firefighter Update Form ([http://iqcs.nwcg.gov/articles/forms/28-iqcs-responder-update-sheet]) with copies of training certificates, resource orders, performance evals, and completed taskbooks to your home unit at the end of the season.
PIO RESOURCES

NIFC PIO Bulletin Board https://www.nifc.gov/PIO_bb/pio_main.html
National Fire Maps https://www.nifc.gov/fireInfo/fireInfo_maps.html
Geographic Area Coordination Centers (GACC) Portal http://gacc.nifc.gov/
National Fire Weather http://weather.gov/fire
NWCG Glossary of Wildland Fire Terminology http://www.nwcg.gov/glossary
ICS Forms http://www.nwcg.gov/publications/ics-forms
Taskbooks http://www.nwcg.gov/publications/position-taskbooks
NWCG Qualifications http://www.nwcg.gov/training-and-qualification-links
Joint Information Center (JIC) Model including job aids http://bit.ly/JICModel
USFS Fire and Aviation Qualifications http://www.fs.fed.us/fire/publications/index.html#fsfaqgForest
Unit Identifiers https://wfmi.nifc.gov/unit_id/Publish.html
Frequently Asked Questions http://www.nifc.gov/aboutNIFC/about_faq.html
Firewise http://www.firewise.org and Fire Adapted Communities http://www.fireadapted.org/
Ready, Set, Go! http://www.wildlandfirersg.org/
What to Do Before, During, and After a Wildfire http://www.ready.gov/wildfires
How to Protect Your Family from the Health Effects of Smoke http://airnow.gov/index.cfm?action=topics.smoke_events
Burned Area Emergency Response http://www.nifc.gov/BAER/Page/NIFC_BAER.html
Sample Resources for Evacuees Returning Home http://nmfireinfo.com/information/after-a-wildfire/

FIRE DATA IN GOOGLE EARTH

BASIC - Most large fires on Inciweb have an interactive Google Earth map on the main incident page (This map is generated based on the coordinates you enter into the 209 data entry screen in Inciweb). Anyone can view the map, scroll around to view different areas, zoom in and out, and select a hybrid or terrain view without having to install Google Earth on their computer.

ADVANCED - You must have the Google Earth program installed and open on your computer before opening the layers below. You can download the free program at www.google.com/earth.

- For a more detailed view with almost real-time info showing approximate heat visit http://activefiremaps.fs.fed.us/googleearth.php. Click on the “Current” AFM KML Bundle.
- Many fire perimeters are also available through GEOMac (http://www.geomac.gov) Click on "View Perimeters" then "View KML" and choose the perimeter to view or download the dynamic KMZ (http://www.geomac.gov/asp-bin/GeomacKML/GeoMAC.kmz).
<table>
<thead>
<tr>
<th>SAT</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>FRI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>THURS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WED</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TUES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MON</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**CALENDAR** *(Time Due Sun)*
INCIDENT WITHIN AN INCIDENT EMERGENCY ACTION PLAN

Introduction
An emergency such as a helicopter accident, firefighter entrapment or burn over, camp evacuations, vehicle accident, medical emergency or other unknown emergency condition could occur on any of the wild fires or all-risk incidents we may be assigned. This may result in serious injuries or fatalities, and periods of extreme stress. This is called an “incident within an incident (IWI).”

Assignments may be in remote or severely impacted locations that result in longer than normal response times for local emergency response personnel; therefore, the team is responsible for handling the situation professionally, timely and effectively.

The intent of this plan is to establish a process and protocol to effectively manage an emergency situation (IWI) while continuing to manage the primary incident with as minimum of distraction as possible.

General Procedures
In the event of an emergency IWI, notification will be made thru the chain of command to the Operations Section Chief and/or Safety Officer. The Operations Section Chief (OSC) will assume control of the emergency and promptly assign on-scene responsibility to an appropriate Division/Group Supervisor or other individual not directly involved with the incident. If OSC cannot be contacted, the highest qualified operations person or safety officer on scene will assume command of the emergency and take appropriate action.

The Incident Commander, Medical Unit Leader and Communications will be notified promptly. The IC will ensure that all remaining command and general staff are notified.

All incident personnel will be instructed by the OSC or Safety Officer to clear the designated radio channel for “emergency traffic” related only to the emergency situation. If OSC or Safety Officer cannot be contacted, the highest qualified person on scene will broadcast “emergency radio traffic.” If available, air attack will be over the incident to ensure clear communications are in effect and will be available as an airborne repeater if needed. In the event personnel are injured, when they have been loaded and being transported to the hospital or at an appropriate time, OSC or Safety Officer will announce on the radio that “emergency radio traffic” has been canceled.

Names of the injured or deceased individuals will not be transmitted on the radio.

To aid in an investigation, deceased individuals or their personal effects will not be moved except to accomplish rescue work or to protect the health and safety of others.

Those directly involved will provide written documentation of their actions. An ICS 214 may be utilized for the initial documentation, but a subsequent narrative will be required.

An After Action Review will be conducted after each emergency incident within an incident to determine strengths and needed improvements.

Functional Assignments
When an emergency situation occurs, all Command & General Staff should quickly assess the situation. The following tasks should be accomplished as appropriate.

Incident Commander (IC)
1. Ensures implementation and accountability of the Incident within an Incident Emergency Action Plan.
2. Notifies the Agency Administrator and Geographic Coordination Center as needed.
3. Approves release of all information regarding the emergency.
4. Determines the need for a Serious Accident Investigation Team (SAIT), if it is a fatality or entrapment on an USFS incident, USDA OIG must be notified by Agency Administrator, and will be the lead on this type of investigation.
5. Determines the need for a Critical Incident Stress Debriefing Team (CISD Team). The request will be routed through the Agency Administrator.
6. Determines which outside authorities need be contacted and initiates contact.
7. In the event a public evacuation is needed, the IC will inform the county sheriff and other officials as needed.
Safety Officer (SOF)
1. Coordinates with and supports the Division/Group Supervisor or person in charge at the scene of the emergency.
2. Initiates investigation and makes recommendation for additional investigation teams as needed.
3. Secures witnesses names and initial statements.
4. Obtains sketches and photos of emergency scene.
5. Obtains assistance from incident Law Enforcement in conducting the initial investigation.
6. Establishes contact with the local Emergency Operation Center prior to an emergency to provide the center with a copy of the Emergency Action Plan and to arrange for a communication link.
7. Completes the wild fire entrapment/fatality initial report (NFES 0859) as needed.

Information Officer (PIO)
1. Prepares and coordinates the release of information in accordance with agency policy and the direction and approval of the IC and Agency Administrator.
2. Provides photo and video equipment and operators to assist with the investigation as requested.
3. Arranges briefings for incident personnel.
4. For additional responsibilities, see following pages.

Operation Section Chief (OSC)
1. Implements the Incident Emergency Plan. Supervises the Division/Group Supervisor or person assigned to manage on-scene responsibility of the emergency incident.
2. Identifies nature of incident, number of people involved and their medical condition, location of emergency, and need for transportation and special needs (law enforcement, haz mat, etc).
3. Coordinations air operations as needed.
4. Ensures appropriate WI organization is put in place to manage the emergency.

Logistics Section Chief (LSC)
1. Orders needed resources for the emergency as requested.
2. Provides ground transportation as needed.
3. Communicates with hospital and ambulance services. Refers to medical plan in place.
4. Coordinates security as necessary to protect accident scene.
5. Arranges for damaged vehicle removal as needed.
6. Provides EMT’s to stabilize patients and to accompany injured to hospital.
7. Supervises camp evacuation as needed and ensures evacuation is done calmly and safely.
8. Provides law enforcement officers to assist the Safety Officer with investigation.
9. Provides emergency meal, potable water and supplies to personnel at the emergency site.
10. Communications will monitor the radio and ensure radio channel remain open for emergency communications only.
11. If a fatality has occurred, contacts the county coroner and sheriff’s office.
12. Develops camp evacuation plan in advance of emergency in conjunction with Safety Officer & LSC.

Planning Section Chief (PSC)
1. Develops camp evacuation plan in advance of an emergency in conjunction with the Safety Officer and LSC.
2. Provides resource information, maps and other data as requested and maintains documentation.
3. Human Resource Specialist(HRSP) will:
   - Coordinate with and arrange needs for Critical Incident Stress Debriefing (CISD) Team.
   - Identify and meet personal needs of affected personnel.
   - Document all post incident activity.
   - Locate and secure personal effects of injured personnel.

Finance Section Chief (FSC)
1. Coordinates with agency administrative staff.
2. Coordinates Compensation/Claims Unit response.
In the event of a serious accident or an incident within the incident, there are certain responsibilities that the lead PIO will assume. According to the Organization document for Serious Accidents, PIOs should follow these steps:

- During the Agency Administrator Briefing, set up the protocol to be used in releasing information with the local agency:
  A) The usual manner would be to have the local unit authorize the release of information.
  B) Set up who will be the accident contact with the local unit. This person might be the public Affairs Officer or Administrative Officer. Set up how the release of accident information will be handled with the incident Commander.
  C) Once an accident occurs, confirm the protocol will be followed with the local agency.

- Make sure that no names are released to media until the official release is done by the local unit.
- Restrict media from the accident scene until the Accident Operations Section Chief authorizes entry.
- Work with the Security Manager to prevent accident survivors from being interviewed until authorized.
- Work with the Safety Officer to gather correct information in preparing any news releases.
- Set up a press conference and/or interviews with the IC or another assigned person (i.e., local unit representative) after the official release of information.

The official release of information regarding serious accidents or fatalities will nearly always be a responsibility of the local unit.

**After a fatality:** Restrict media access until bodies have been removed and all families notified. Then provide media a tour date and time and escort them to the scene.

**Lead PIO** (should NOT be unit PAO)
- Contact AA or IC for initial briefing
- Contact Agency PAO
- Delegate the Command Staff Information Officer duties to another qualified Information Officer for the Fire Incident.
- Designate Internal, Media & Community PIOs
- Place order for additional PIO staff.
- Set up notification process to ensure all PIOs / PAOs are notified when talking points are updated.
- Ensure PIOs take frequent short breaks
- Develop talking points for approval
- Obtain authorization for all info release
- Interface with / distribute approved talking points to:
  - IC / C&G / Liaison Officer
  - Agency Administrator
  - Agency PAO - request they contact:
    - Regional / national public affairs
    - Agency frontliners – dispatchers, receptionists, etc.
    - Agency FOIA Coordinator
  - Incident PIOs
  - Elected Officials
  - Partner agency PAOs / PIOs
  - Sheriff’s Department
  - EOC
  - JIC
  - MAC / Area Command
  - FAA / NTSB
  - FAST / SAIT
  - CISM
- Brief PIOs with incoming teams
- Prepare transition plan which incorporates follow-up including:
  - Continuing impacts, staff rides, visitors, traffic, media, production companies, etc.
  - Need for follow-up committee
  - Requests for dedication memorials (plaques and statues)
  - Plan for facilitating return visits to the incident site by family members/survivors/visitors
  - Evaluate public information activities / adjust communication plan as appropriate
  - Provide updates to family members
Internal Lead
- Chase down rumors
- Interface with operations for updates
- Update camp boards / spike camp
- Post paper next to chow line for firefighters to write notes to family
- Prepare for incoming teams / VIPs
- Prepare briefing packets
- Designate liaisons/escorts
- Arrange for transportation
- Help coordinate press conferences
- Keep key personnel informed
- Provide regular updates and contact with all internal / family PIOs

Normal Fire PIOs
- Continue to provide fire info operations

PIO to work with Family Liaison:
- Update family before info released to media
- Ask family if they want to talk to the media
- Contact home unit PIOs to help coordinate media contacts with families back at home
- Protect the rights of those who do not want media contact
- Prepare condolence letters within 24 hours (coordinate at all levels in the agency)
- Arrange escorts for families, etc.

Community Lead
- Post approved talking points in information center (to be updated with approved messages only)
- Oversee information center operations
- Provide regular updates and contact with all office / community PIOs

Community PIOs
- Update / staff community info boards

Office PIOs
- Staff info center phones
- Update website with approved info
- Periodically check e-mail and monitor blogs
- Prepare thank-yous and commendations
- Tasks for volunteers: herding, faxing, etc.
- Maintain documentation file

Field PIOs
- Intercept looky-loos and reporters on scene, in camp, at hospital, helibase, etc.
- Provide media / VIP escorts
- Coordinate media access to accident site, overflights, memorial services, etc.

Media Lead
- Identify / serve as primary spokesperson
- Provide regular updates and contact with all field / media PIOs

Media PIOs
- Contact reporters via phone / return calls as soon as releasable info available / updated
- Prepare news release(s) for approval
- Distribute approved news release
- Prepare photos/bios of victims
- Arrange press conferences
- Designate “media-free” space for incident personnel.
- Designate media briefing area.
- Consider media needs – phones, work areas, parking, deadlines, PPE, photo opportunities, interviews, etc.
- Need for pool photographer?
- Publicize info phone / website
- Incorporate key messages
- Monitor media coverage

MEMORIAL SERVICE CONSIDERATIONS
- Set up a hotline with a recorded message and/or a website where info will be shared as soon as it is available.
- Embed PIOs in planning effort.
- Set up an e-mail or phone number for RSVPs to help anticipate attendance.
- Work with family to obtain photos, bios, establish memorial website, address and e-mail to send condolences, preferred charity, memorial and funeral service info, etc.
- Clarify and share information on agency protocol regarding travel, admin leave, uniforms, use of go’v’t vehicles, flag-lowering, and wearing of black bands.
- Arrange for photos / video of service.
- Ensure PIOs are familiar with program: names and relations of speakers, where the honor guard is from, immediate family members’ names, what types of aircraft are flying in tribute, etc.
- Thank yous for incident personnel, flowers, gifts, donations, etc.
INCIDENT-WITHIN-AN-INCIDENT QUESTIONS TO ASK

Discuss with Incident Commander / AA
- Who will handle info release – Incident or Home Unit?
- Who will approve info release – IC or AA?
- What other agencies will be releasing information (Sheriff, Contractors, etc.)?
- Who will speak for the incident if there is an immediate press conference?
- What information is confirmed?
- What information is NOT releasable?
- If names are being withheld, who will know once family has been notified and tell IC?
- When the IC decides to release the names, how will information find out?
- How will families / home units / other people most directly affected be provided with critical information?
- How will incident personnel be notified?
- How will agency personnel be notified (Safety Manager, Personnel Officer, PAO, LE Staff, Aviation Mgmt, Solicitor, Tort Claims Officer, etc.)?
- How will national personnel be notified (agency director, agency administrators, OIG, etc.)?
- Who will contact WFF Foundation?
- How will cooperator personnel be notified?
- How will fire home unit personnel be notified?
- What about specialized help like animal trailers during an evacuation?

Discuss with Agency PAO
- Does host agency have qualified PIOs locally?
- Can any nearby incidents loan staff?
- Bring PAO on site with PIOs?
- Need to establish JIC?
- Need to establish 800 number?
- Can incident assist cooperators in need of phones, press conference location, etc.?

Discuss with C&G Staff
- Will incident personnel be authorized to make one short call home using the incident’s cell or stationary phones?
- Are technical experts (safety, aviation, fire behavior, etc.) available and prepared for media interviews?

Discuss with Operations
- Media access, including overflights?
- Potential for press to block access / how to manage?
- How and when will PIO receive updates?
- Designate an operations liaison to be available to resolve questions of fact.

Discuss with Plans
- Do any personnel assigned to incident have PIO quals?
- Need for maps / graphics?

Discuss with Logistics
- Additional logistics needs for info function – radios, etc?
- Need to establish media briefing area?
- Need to establish media-free areas for incident personnel & family?
INCIDENT-WITHIN-AN-INCIDENT - FIRST MESSAGE
Crisis & Emergency Risk Communication - http://emergency.cdc.gov/cerc/

1. Expression of empathy
   - Provide information to victim/family first.
2. Clarifying facts
   - State only facts. Do NOT speculate. Confirm the obvious.
3. What we don't know
   - Document all individual actions on unit log.
4. Process to get answers
   - Restrict radio communications. Share info via phone or face-to-face.
5. Statement of commitment
6. Referrals

We are aware that an [accident/incident]________________________________ involving [type of incident]________________________________ occurred at approximately [time]__________________, in the vicinity of [general location]_________________.
[Agency personnel]_________________________________ are responding,
And we will have additional information available as we are able to confirm it.
We will hold a briefing at [location]____________________________, and will notify the press at least [time, ie. ½ hour]____________________ prior to the briefing. At this time, this briefing is the only place where officials authorized to speak about the incident and confirmed information will be available.

Thank you for your assistance.

Check message for:
- Positive action steps
- Honest / open tone
- “We” not “I”
- Be careful with early promises

Avoid jargon
Avoid judgmental phrases
Avoid humor
Avoid extreme speculation

RELEASABLE INFORMATION
- How many people involved / number and type of injuries / number of fatalities
- What happened / type of accident or incident
- When
- Where / location of incident / property owner
- Response Actions / identification of responding agencies

Do NOT Release without Agency Administrator permission:
- Names of Fatality Victims, including juveniles (only after next of kin are notified)
- Names of Injured or Missing Victims
- Names, ages, home units and hometowns of the individuals involved in the incident.
- Crew names, aircraft characteristics or designators or other identifying info
- Description of lost, stolen, or missing property.
- Criminal charges if applicable.

Do NOT Release:
- Home Address, Phone, or Social Security Number
- Names of Juveniles Charges with Criminal Offenses
- Names of Victims of Sexual Assault
- Names of people or witnesses who may become victims of crime or retaliation in the future
- Information on incidents where criminal action is still under investigation and information released could hinder or adversely affect the investigation.
- Investigative information beyond general incident reporting
- Explicit details, including graphic photos or images of extreme injuries or brutal fatalities.
INCIDENT-WITHIN-AN-INCIDENT - FIRST MESSAGE

Expression of empathy
- This is an evolving emergency and I know that – just like we do – you want as much information as possible right now. I wish I could answer all of your questions here. While we work to get your questions answered as quickly as possible, I want to tell you what we can confirm right now.
- Our ___________ (hearts / deepest condolences) go out to the __________ (firefighter’s last name) family and friends during this very tragic time.
- ___________ (firefighter’s name) is a member of our __________ (agency) ‘family,’ and will be deeply missed.
- He/she took on a difficult job, and served our nation well, in the finest tradition of the __________ (agency). His/her through his/her dedication, courage, and spirit – will live on in the hearts and minds of all of us.
- Our thoughts and prayers are with __________ firefighter’s name) family, friends, and co-workers.

Clarifying facts (VERIFIED facts only, skip if not certain)
- On ___ (date) firefighter ___________ (name), an ___________ (age)-year-old __________ (agency) firefighter based out of __________ (home unit) in ___ (state) ___________ (describe situation - received multiple injuries yesterday, was killed while ___________ (clearing trees, etc.) while working on the ___________ (fire name) fire on the ___________ (unit name) in __________ (state).
- We are extremely relieved that no one was apparently injured in this incident
- The crew has been taken off the fire pending investigation into the incident.
- It is with great sadness that we confirm the names of the ___________ (agency) firefighters who tragically lost their lives while in the line of duty ___________ (when).

What we don’t know
- At this point, we do not know ___________ (# of injuries, # of deaths, cause of accident, etc.)
- All of our efforts are directed at bringing the situation under control, so I’m not going to speculate about the cause of the incident.

Process to get answers
- We have a system (plan, procedure, operation) in place for emergencies such as this and we are being assisted by __________ (Sheriff’s Dept. etc.) as part of that plan.
- We’ve just learned about the situation and are trying to get more complete information now.
- The accident investigation is ongoing.
- _____ (park mangers, etc.) are working with _____ (Sheriff’s Dept, etc.) to ensure site safety and integrity.
- The ___________ (DOI’s Aviation Management Directorate, etc.) will participate in the crash investigation, which is being coordinated with the _____ (National Transportation Safety Board, Federal Aviation Administration, etc.).
- An interagency (DOI, Contractor, FAA, Serious Accident Investigation Team, etc) investigation team is scheduled to arrive in __________ (location) _______ (when) to conduct a review of the incident.
Statement of commitment
- The situation is ________ (under, not yet under) control and we are working with ________ (local, state, federal) authorities to (contain this situation, determine ______ (how this happened, determine what actions may be needed by individuals and the community to prevent this from happening again.)
- Whenever injuries such as these occur during firefighting operations, a top priority is to learn everything we can about them so we can work to prevent similar incidents from happening again.
- People are our most valuable resource and we remain committed to the safety of our firefighters. We cannot forget that there are still ______ (number) firefighters continuing to work to suppress fires here in ______ (location). We’ve made great progress but much remains to be done.
- Our interagency fire teams develop strategies for fighting a fire. Fire managers continue to consider fire behavior, weather forecasts, terrain, accessibility and proximity to communities when considering fire suppression strategies.
- We must consider firefighter safety in all of our tactical decisions. Firefighter and public safety will remain our number one concern.
- As a precaution, all ________ (aviation, etc.) operations on the ________ (home unit, etc.) are discontinued until further notice.

Referrals (if possible, skip if not yet ready)
- We will continue to gather information and release it to you as soon as possible. I will be back to you within ________ (amount of time, 2 hours or less), to give you an update. As soon as we have more confirmed information, it will be provided. We ask for your patience as we respond to this emergency. For more information...
- The name will be released by the ___________ Sheriff’s Department pending notification of family members.
- Next scheduled update...
- Calls on this incident will be taken starting at 0800 tomorrow morning (date) at the following numbers: ____________.
- How can I reach you when I have more information?
- I’m not the authority on this subject. Let me have ____________ (name) call you right back.
- We’re preparing a statement on that now. Can I fax it to you in about two hours?
- You may check our web site for background information and I will fax/e-mail you with the time of our next update.
- Photographs will be made available as soon as possible at ________________________.
- A fund will be established by the Wildland Firefighter Foundation in ____________ (firefighter’s name) name. The foundation is online at http://wffoundation.org/ and can be contacted by calling 877-336-2950.
INCIDENT-WITHIN-AN-INCIDENT FACTS

BOLD CAPS = RELEASABLE INFO / *All other info DO NOT RELEASE without AA approval.*

INITIAL REPORT BY:  
TO WHOM:  
DATE/TIME:

# PERSONNEL INVOLVED:  
# VEHICLES:  
# INJURIES:  
# FATALITIES:  
# OK:

WHAT WERE THEY DOING AT THE TIME?

RESPONSE RESOURCES:  
RESPONSE TIME:

RESPONSE ACTIONS:

<table>
<thead>
<tr>
<th>FIRE NAME:</th>
<th>IMT/IC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOME UNIT:</td>
<td>LOCATION/STATE:</td>
</tr>
<tr>
<td>CAUSE:</td>
<td>START DATE:</td>
</tr>
<tr>
<td># PERSONNEL:</td>
<td>FUELS:</td>
</tr>
<tr>
<td>TERRAIN:</td>
<td>WEATHER:</td>
</tr>
<tr>
<td>Name:</td>
<td>Age:</td>
</tr>
</tbody>
</table>

TRANSPORT:  
HOSPITAL:  
LOCATION:

HOSPITAL PAO NAME & PHONE:

INJURIES:  
Treatment:  
Cause of Death:  
Affiliation:  
# Members:  
Location:  
Home Unit:  
Agency:  
State:  
Hometown:  
Yrs in Fire:

EQUIPMENT TYPE:  
Name:  
Make/Model:  
Damage:  
Driver/Pilot:  
TOTAL # ONBOARD:  
Names Onboard:

Description of lost, stolen, or missing property:

Criminal charges:
### PASSWORDS

<table>
<thead>
<tr>
<th>WEBSITE</th>
<th>USERNAME</th>
<th>PASSWORD</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAP - <a href="https://nap.nwcg.gov/NAP/">https://nap.nwcg.gov/NAP/</a> FAQ – Resetting Password, etc.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><a href="http://ross.nwcg.gov/user_support/NAP.html">http://ross.nwcg.gov/user_support/NAP.html</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WFDSS <a href="http://wfdss.usgs.gov">http://wfdss.usgs.gov</a></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Disclaimer** While the goal is to make this information as timely and accurate as possible, there are no claims, promises, or guarantees about the accuracy, completeness, or adequacy of the contents of this document. Liability for errors and omissions in the contents of this document is expressly disclaimed. No warranty of any kind, implied, expressed, or statutory, including but not limited to the warranties of non-infringement of third party rights, title, merchantability, fitness for a particular purpose or freedom from computer virus, is given with respect to the contents of this document or its links to other Internet resources. Reference in this document to any specific commercial product, process, or service, or the use of any trade, firm or corporation name represent examples for information and convenience and does not constitute endorsement, recommendation, or favoring.